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1 Introduction

Removal Sampling 2 is designed to help you to estimate population size using modern
removal sampling techniques. 

The program also offers some statistical tests for the appropriateness of the model used,
and a graphical presentation of the results. This program is suitable for both scientists
and students with limited mathematical knowledge.

With its easy to use interface and extensive help, Removal Sampling v2 is an ideal
program for undergraduate and post-graduate students.

Removal Sampling Version 2 includes the following additions and enhancements:

 An improved user interface and graphics
 Improved help system with tutorials
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2 Getting Started

This page helps you navigate to the areas of the help file to get you started.

Select the jumps below for help on 
Installation 
entering your data
Open a data file
Choosing a method
Printing your Results
Copying your Results.

The quickest way to understand how to use the program is by using the demonstration
data set.



Part

III



Using Removal Sampling 2 11

© 2007 Pisces Conservation Ltd

3 Using Removal Sampling 2

Removal Sampling 2 offers a number of methods for the estimation of population size
using removal sampling methods. For details of the methods see:

Constant p
Variable p
Regression
Carle & Strub

For details about how to use the program see:

Main window
Editing and changing graphs
Editing data
Printing and exporting your results
Copying
Entering data

To see a worked example see the tutorial.

3.1 Entering data

Demonstration data sets
An example data set is supplied with the program. This allows the user to test the
program, and can be opened in a spreadsheet or word-processor program to examine the
way the data are organised. 

Creating data sets
Data sets can be created within Removal Sampling 2, or by using a spreadsheet such as
Microsoft Excel, or many other spreadsheets, word processors, database programs, etc.
We recommend that you organise large data sets using a spreadsheet such as Excel, as
this will give access to a wide range of sorting and editing procedures to ease your task. 

Creating a data file using a spreadsheet

Creating a new data set within Removal Sampling 2

3.1.1 Creating a new data set within Removal Sampling 2

Datasets can be created both within and outside Removal Sampling 2. To start a new
dataset from within Removal Sampling 2 select File|New. This will open a blank grid
into which you can type your data.
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The data comprise the number of animals captured for the first time in samples 1 to n,
arranged in columns. Enter data in each cell by clicking on the cell and typing. Columns
and rows can be added or deleted using the tool bar above the grid.

To set an initial number of rows and columns use the size grid tool on the tool bar which
has the square icon-

To select a row and column number just drag the mouse over the grid with the left-hand
button depressed and then release. As the pointer is dragged over the grid the selected
size will be shown in blue as follows -

 

Remember that for larger data sets you are advised to use a spreadsheet to create your
dataset, as it will give you superior editing and data search facilities. See Creating a data
file using a spreadsheet. 

To see an example of data collected using electric fishing in a stream, open 
RemovalDemo.csv - stored by default in ..\My Documents\Removal Sampling
Data\Demo Data.

3.1.1.1 Editing data

To edit an open data set click on Data tab to display the data grid. Double click on the
cell you wish to edit and type in the new value. If you wish to undo an alteration use 
Edit|Undo or Ctrl-Z

Above the data grid there is a tool bar which allows the shape of the grid to be changed
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by adding or removing rows and columns. The purpose of each button will be displayed if
you hover with the cursor over any of the buttons.

By default, the toolbar is docked on the main program window; if you wish, you can drag
it so that is displayed free from the main window, by clicking on the dotted vertical line
at the left of the toolbar, and dragging:

To re-dock the toolbar on the main window, either click the X in the top right corner of
the toolbar, or drag it back to its original position on the main program window.

To make major changes to a large data set it may be quicker to open the data set in a
spreadsheet program.

3.1.2 Creating a data file using a spreadsheet

A data set is stored as a comma-delimited text file with the extension .csv. Removal
Sampling will also open Excel files. It is normal to initially organize your data in a
spreadsheet such as Excel. The data are organized as a simple 2-dimensional array as
follows: 

This example is the demonstration file RemovalDemo.csv opened in Excel.

You should create a completely new spreadsheet file, and enter your data into it, rather
than create a new sheet on an existing spreadsheet - which might for instance contain
raw data and other information from your sampling. This is because the csv file format
can only support a single worksheet. Make sure that no other data apart from the sample
data grid is present on the worksheet. It is good practice to select the first 10 or so rows
and columns, below and to the right of the data grid, and press the Delete key, to
remove any data or blank spaces accidentally entered into cells outside the data grid.
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When you have added all the data to your data set, click File: Save As, choose a name
for your file, and select CSV (Comma delimited) (*.csv) from the Save as type
drop-down menu (see below). You will receive a warning that the CSV file type does not
support workbooks containing multiple sheets; press OK to ignore this warning, then
click 'Yes' to ignore the next warning, that the sheet might contain features not
compatible with CSV.
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3.1.3 Maximum size of the data set

Removal Sampling 2 has been written to handle 100 columns by 100 rows of data set. A
larger version can be made on request - contact us

3.2 Main Window

Start Removal Sampling 2 in the normal Windows fashion either by clicking on the
desktop icon or from the Start menu. The program appears with no open data set, as
shown below:

Along the top bar are a number of drop-down menus. These work in the same way as
most standard Windows programs. 

File: To open and create data sets, save files and print results.
Edit: To copy or export the graph or the data and predicted results.
Method: To select a model to estimate population size.
Help: to enter the Help system. Context specific help can also be obtained for each
method by opening its window and then clicking on the right hand mouse button, or
by pressing the F1 key on your keyboard.

The data and results are shown in three tabbed windows. Just left click on a tab to select
it. 

Data: This tab shows age and size data. For example, it will be displayed if you have
entered or opened a data set that comprises age and length data for individual
organisms.
Calculations: This tab presents the observed and predicted values.
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Graph + Results: This tab presented a plot of the observed and predicted fit plus
model parameters and diagnostics for length data.

To get you started Removal Sampling 2 comes with a demo data set. 

Use File|Open to find and open RemovalDemo.csv (saved by default during
installation in the folder ..\My Documents\Removal Sampling Data\Demo Data) 

This will give a plot of your data in a tabbed output. Upon opening the data set 
Removal Sampling 2 automatically fits a constant probability model using non-linear
methods. If you wish to fit another model, this is easily accomplished - choose another
from the Method drop-down menu:

3.2.1 Data Tab

Click on this tab at the bottom of the main window to show the data grid. 
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The example below is the data for our demonstration data set RemovalDemo.csv 

Data can be edited, saved, copied or printed. 

To print, export or copy the grid see Print Grid and Copy Grid

If you have a number of columns of data for different species, as in the example above, 
Removal Sampling 2 will initially analyse the summed data for all the columns. You can
select which of the columns to analyse, by clicking in to the column title cell, so that a
red dot is displayed (see image above) in the column(s) you wish to analyse. Click again
to remove the red dot, and deselect that column. For example, to only analyse Minnow,
click on the title cells of the other three columns, so that only the red dot alongside
Minnow remains. 
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Each time a column is selected or deselected, the calculations are performed on the
selected columns, using the default model from the Method menu, and the results are
displayed on the Calculations and Graph + Results tabs. To use a different model, simply
select the one you want from the Method drop-down menu.

3.2.2 Calculations Tab

This tab at the bottom of the main window shows the calculations for the selected model.

This tab shows a grid giving both the Observed (entered data) and the Expected numbers
of captures for each run for the selected model. The model used is shown in the title of
the Results grid.  The third column gives the estimated probability of capture. If a
Constant P model has been chosen, then this value will be the same for each run.

The grid below shows the results for a constant probability model using the file 
RemovalDemo.csv.
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To print, export or copy the grid see Print Grid and Copy Grid

3.2.3 Graph +  Results Tab

This tab at the bottom of the main window shows the plot for the selected model.

Click on this tab to see a plot of your data, plus the fitted model and a grid of the
parameter estimates and statistical diagnostics. 
The screen is arranged into a number of panels. 
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The graphical menu bar at the top of the chart can be used to change many features of
the plot. 
The chart is active, and features of the plot can be edited by moving the cursor over
them and double-clicking. 
The results are tabulated in the bottom grid. The data in this grid can be printed, copied
and exported.
 
For a fuller exploration of using the graph, see Editing and changing graphs.

The grid below the chart gives the parameters and diagnostics for the selected model
(shown in the title of the plot and at the top of the grid).

3.3 File

Use this drop-down menu to open and create data sets, save files and print results.
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Options are as follows:
Open
New
Save: saves the data file as a csv file.
Save As: allows you to select a name for the saved file.
Export: exports the data in a variety of formats
Reopen: Lists the most recently-used data files
Print Chart
Print Grid
Printer Setup: allows you to select printer options
Exit

3.3.1 Saving a data set

To save the current data set, use Save or Save As from the File menu.
 
Save your data as either a .csv (Comma-separated values) file, or an .xls (Excel) file.

.csv files are more flexible as they can be opened and edited in many different programs.

3.3.2 Export data

The Export Active Grid function allows you to save the data grid on the active (i.e.
visible) tab, in a variety of formats:
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CSV - As a comma-separated value (.csv) text file, which can be opened in Excel, other
spreadsheets, word processing software, or notepad.
ASCII - As a plain ASCII text file.
XLS - As a formatted Excel spreadsheet file.
HTML - As a formatted table for use in an HTML document such as a web page.

3.3.3 Closing the program

Choose Exit from the File menu, or the cross symbol at the top right corner of the
program window to close Removal Sampling 2.

3.3.4 Open an existing data file

Use File|Open to select a data file for analysis. To choose the type of file to open, select
the relevant extension from the Files of type drop-down menu on the Open File dialog. To
reopen a recently opened dataset select one from the Reopen: list on the menu.

Removal Sampling 2 can open .csv (Comma-separated value) files and .xls (Excel) files.
.csv files can be created in many programs including Excel, Lotus, Word, Notepad and
Write.
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3.4 Methods offered in Removal Sampling 2

Removal Sampling 2 offers four methods of estimation for the total population size.

Constant p
Variable p
Regression
Carle & Strub

Generally, you should use the Constant p (probability method). This is also known as
Zippin's method.

3.4.1 Constant probability of capture

This is called the  constant p method in the program (p for probability of capture). It is
also known as Zippin's method, although this probably more correctly refers to a method
of solution.

Maximum Likelihood (ML) estimates for estimating population size (N) for a constant
probability of capture model were first published by Moran, 1951 and developed by
Zippin, 1956. To apply the method the following conditions must be satisfied:

1. The catching or trapping procedure must not lower (or increase) the probability of
an animal being caught. For example, the method will not be applicable if animals
are being searched for and, as is likely, the most conspicuous ones are removed
first.

2. The population must remain stable during the trapping or catching period; there
must not be any significant natality, mortality (other than by the trapping) or
migration. The experimental procedure must not disturb the animals so that they
flee from the area. 

3. The population must not be so large that the catching of one member interferes
with the catching of another. This is seldom likely to be a problem with insects or
fish where each sample can take many individuals, but may be significant in
vertebrate populations where one trap can only hold one animal.

4. The chance of being caught must be equal for all animals. This is the most serious
limitation in practice. Some individuals of a population, perhaps those of a certain
age, may never visit traps and so will not be exposed to collection. In vertebrates,
'trap-shyness' may be exhibited by part of the population such as one sex. In
electric fishing, where the method is used extensively, smaller individuals are more
difficult to stun, and individuals occupying territories under banks or other
obstructions may be particularly difficult to catch. 

Zippin (1956 & 1958) has considered some of the specific effects of failures in the above
assumptions. If the probability of capture falls off with time the population will be
underestimated, but if the animals become progressively more susceptible to capture,
the population will be overestimated. Changes in susceptibility to capture will arise not
only from the effect of the experiment on the animal, but also from changes in behaviour
associated with weather conditions or a diel periodicity cycle.

The expected number captured on each sampling occasion E(us) is
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where T is the total number caught over all k samples and q = 1-p. First R is calculated
and then Eq. 7.3 is solved numerically for q. This value is then used in Eq. 7.2 to
estimate N. 

The standard error of the estimate of N is given by:
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where the notation is as above 

If the lower confidence interval is less than the total number of captures, T, then T
should be taken as the lower confidence interval 
It has been shown by Zippin (1956 & 1958) that a comparatively large proportion of the
population must be caught to obtain reasonably precise estimates. His conclusions are
presented in Table 1, from which it may be seen that, to obtain a coefficient of variation
(C.V. = Estimate/Standard error x 100) of 30%, more than half the animals would have
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to be removed from a population of less than 200. 

Table 1:  Proportion of total population required to be trapped for specified coefficient of
variation of N (after Zippin 1956).

Coefficient of
variation

30% 20% 10% 5%

200 .55 .60 .75 .90

300 .50 .60 .75 .85

500 .45 .55 .70 .80

1,000 .40 .45 .60 .75

10,000 .20 .25 .35 .50

100,00 .10 .15 .20 .30

3.4.2 Variable probabilities of capture

Removal Sampling 2 offers a model in which the probability of capture on the first
sampling occasion is different from that on subsequent samples. 

To use the variable p method, sampling must have been carried out on at least 4
occasions.

It will often be observed that the probability of capture changes during the course of a
study. For example, larger fish are more easily caught when electric fishing. Thus the
first sweep along a reach of a stream will tend to have a higher rate of capture. Generally
the best way to deal with this problem is to divide the population into a number of
groups, each of which can be independently estimated with a constant probability model.
This is easily done using Removal Sampling 2, as each column can comprise a particular
species or size class. An example of such a subdivision is shown in the demonstration
data set RemovalDemo.csv.

In an electric fishing survey of a stream it might be appropriate to undertake
independent analyses for eel, trout and minnow and to further subdivide the trout into
size (age) classes. However, the ability to avoid capture even varies between individuals
of a single age or size class, and if this effect is large the mean probability of capture will
change in what the observer perceives as a homogeneous population. When a constant
probability model has been rejected, and it is not possible to subdivide the population
then the generalized removal method of Otis et al. 1978 can be used.

A removal experiment does not generate sufficient information to allow the calculation of
a model in which the mean probability of capture on each sampling occasion is different.
This is because there are too many parameters to estimate, given the number of
observations. Otis et al. (1978) noted that as animals with a higher probability of capture
tend to be caught first, the mean probability of capture on sampling occasion k, pk tends
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to decline with increasing k, so that after, say, m samples, pk can be assumed constant.

A family of models can therefore be constructed in which the first 1,2,3 .. k-2 samples
are assumed to have different values for p and all later samples a constant p. In the ideal

world the logical approach would be to work upwards from m = 1 and stop when a 2

test shows that the model can no longer be rejected. In practice it is rarely worth using a
model with k >1 because of the short data series typically collected in removal sampling
experiments and the increased standard error of the population estimate as the number
of estimated parameters increases. In Removal Sampling 2 we therefore only include a
model for the situation where capture probability on the first sampling occasion is
different. To use the variable p method, sampling must have been carried out on at least
4 occasions.

The probabilities of capture are calculated using ML methods similar to those used for the
constant probability of capture model. 

There is a third approach that can be taken if the probability of capture during the first
few samples is lower than in later samples. This effect is observed when sampling fish
such as lampreys which are buried in the substrate and tend to require a number of
passes while electric fishing before they are drawn to the surface where they can be
captured. Examine the graph of the pattern of capture, and remove from the analysis the
initial samples when the probability of capture was low. Then calculate the population
size using the remaining samples with a constant probability model. The total population
is given by the number of captures in the not-used initial samples, plus the population
estimate.

3.4.3 The regression method

This is an old method used before the ready availability of computers to solve the
Maximum Likelihood equations. This method assumes a constant probability of capture.
Because graphical and regression methods have been so widely used and are still
frequently applied, we have included one in the program. It is inferior to the maximum
likelihood approach, and does not give valid estimates of the standard error of the
estimated population size.

If the number caught on the ith occasion is plotted against the total catch up to occasion
i-1, a straight line may be fitted by linear regression (Zippin 1956). The point where this
line cuts the x-axis gives the estimated population size. In the example below, it is
169.66 or 170. 
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3.4.4 Carle & Strub

This method was developed by Carle & Strub (1978) and is also called the Maximum
weighted likelihood method. It was developed for use with catch data that is poor and
fails to provide valid estimates using the maximum likelihood method.

The parameter M is calculated using:

where k is the number of samples taken, and ui the number of animals caught in the ith

sample.
The population size, N is estimated as the smallest integer greater than the total catch,
T, that satisfies the inequality

The above inequality is an approximation of a summation, and can fail for samples when
k=2. The standard error is calculated as described for the maximum likelihood (Zippin's)
method.

You should only use this method when the Constant probability and variable probability
models have failed to give sensible results. This will normally occur when your data do
not show a steady decline in the numbers caught with the number of samples. 
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3.5 Editing and changing graphs

Almost all aspects of the charts in Removal Sampling can be edited. 

Many useful changes can be quickly accomplished using the graphical menu bar buttons.

For instructions to zoom in and out of part of a graphing see enlarging part of a chart.

Many chart features can be edited directly from the chart by simply holding down the
Shift key and clicking on the chart.

3.5.1 Graphical Menu Bar

The graphics bar situated above the charts in Removal Sampling 2 allows you to quickly
edit many features of your graphs. 

The functions of the individual buttons are as follows.

 

Opens the main graphics dialog window which allows you to edit every feature of the
chart.

Prints the chart see Print Chart for more details.

Copies the chart to the clipboard. See Copy/Export Chart for information on file formats.

Saves the chart to a file. See Copy/Export Chart for information on file formats.

Increases the size of the text on the chart.

Decreases the size of the text on the chart.

Increases the thickness of the curve predicted by the model.
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Decreases the thickness of the curve predicted by the model.

Increases the size of the observed data points on the chart.

Decreases the size of the observed data points on the chart.

Switches between black and white and colour graphics.

Switches grid on and off on the graph.

Switches the legend on and off.

Click to select a theme (a style) for your graph.

3.5.2 Enlarging (zooming) part of a chart

To zoom in on part of the chart, move the cursor to the upper right hand corner of the
area you wish to magnify, and hold down the the left hand mouse button. Now without
releasing the button, drag diagonally downwards and to the right. A yellow box will
appear (see below) showing the area that will be enlarged. Release the button and the
highlighted part of the plot will be enlarged. To return to the full plot simply reverse the
process by left clicking and dragging the cursor up and to the left. 
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The enlarged area of the plot is shown below.

3.5.3 Editing directly from the chart

The chart is active, and features of the plot can be edited by moving the cursor over
them and double-clicking on the feature of the plot you wish to alter. For example, to
edit the x-axis, move the cursor over the axis like this:
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and then double-click. The following dialog window will pop up allowing you to change
the chart defaults.

3.6 Printing and exporting your results

The data grids and graphs can be printed using the Print option from the File menu. 

Different printing options are offered for graphs and grids.

Print Grid
Print Chart
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3.6.1 Print Grid

Selecting File|Print Grid 

opens the grid printing dialog, which allows the font and page layout to be selected
before printing.
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3.6.2 Print Chart

Selecting File|Print Chart opens the grid printing dialog, which allows the chart and
page layout to be selected before printing.
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This window shows a representation of the graph on the paper. The print margins are
displayed as dotted lines, and can be dragged by moving the cursor over the margin,
holding down the left hand mouse button and dragging.

3.7 Copying

The data grids and graphs can be copied to the clipboard or exported in different
formations, using the Copy drop-down menu. 

Different options are offered for graphs and grids.

Copying tabulated data (grids)
Copying Charts

3.7.1 Copy Grid

Select this option to copy the data grid from the active (visible) tabbed page to the
Windows clipboard. The data can then be pasted into some other program using Paste or
Ctrl+V. Once the file is copied you will see a confirmation dialog.
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3.7.2 Copy/Export Chart

Selecting Copy|Copy/Export Chart opens the Export dialog.

You can change the colour depth and size of the image if desired. The default file format
for the file is a bitmap; select another file format by left clicking on the format of choice
in the list.

You can also copy a chart using the Copy button on the graphical menu bar.

File formats
The chart can be saved in a number of different file formats:  Bitmap (*.bmp), Metafile
(*.emf), PDF (*.pdf), GIF (*.gif), PNG (*.png), PCX, (*.pcx) and JPEG (*.jpg). Each file
format has advantages and disadvantages.

 Bitmaps are a lossless method of saving; the stored file will not lose any of the
original's detail. Because of this, bitmaps tend to be much larger than compressed
files such as Enhanced Metafiles, GIFs or JPEGs.

 The advantage of Enhanced Metafile is that, if pasted into, for instance, a Word
document, it can be resized by dragging, without losing resolution. 

 PDF is an Adobe Acrobat file, which is a useful format to send to other people or for
inclusion in a pdf document.

 GIFs offer advantages for web use, as they compress the file.
 JPEGs are file formats which can be compressed to take up less space - useful if you

wish to send one by email, put it on a website, or paste it in to a document. If they
are compressed too heavily, they can lose resolution and detail, and spoil colours.
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 PNG and PCX are graphics file formats in common use. PCX format is one of the most
usable graphic formats. Originally it was designed by Zsoft for PC Paintbrush
MS-DOS. PNG (Portable Network Graphics) is a bitmap image format that employs
lossless data compression. PNG was created to both improve upon and replace the
GIF format with an image file format that does not require a patent licence to use.

There are three buttons at the bottom of the screen. Select 

Copy to copy to the clipboard
Save to open a save file dialog window  and 
Send to activate your email system and send the file
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4 Tutorials and demonstration data sets

Upon installation of Removal Sampling 2 a demonstration data set called
RemovalDemo.csv will also be placed on your hard disk. These data are saved by
default in the folder ..\My Documents\Removal Sampling Data\Demo Data. This
data set is used in the help tutorial system.

A demonstration using electric fishing data.

4.1 Electric fishing demo

For this tutorial we will use the demonstration data set RemovalDemo.csv supplied
with Removal Sampling 2. This data set was collected during an electric fishing survey of
a small English chalk stream called the Chitterne Brook. A summary of the method used
is as follows:

Quantitative electric fishing was undertaken at three sites on the Chitterne Brook on the
19th June 2001. This date was chosen to be prior to the introduction of stream support
pumping. At each site a 30 m reach was isolated by stop nets and electric fished in an
upstream direction. All of the fish captured were identified to species and standard
lengths were measured to the nearest millimetre. Systematic fishing of the sites was
repeated until the number of fish captured for all abundant species had declined over 3
successive passes. This was to allow a removal trapping method to be used to estimate
population density. All the captured fish were subsequently released alive. Populations
were estimated using the commercial software package Removal Sampling (Pisces
Conservation Ltd.) to calculate population size using Zippin's method. This method
assumes a constant probability of capture.

To open the data set use File|Open and select RemovalDemo.csv - stored by default
in ..\My Documents\Removal Sampling Data\Demo Data

Removal Sampling 2 will open the data and display the data grid as shown below.
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In this case we undertook 5 electric fishing sweeps of the 30 m stretch of stream. Only
three species were caught; trout, eel and minnow. Because large trout are very much
easier to catch than small trout, the trout numbers have been divided into fish more than
20 cm in length and those less than or equal to 20 cm in length.

When the data set was loaded Removal Sampling 2 immediately undertook a constant p
method using the sum of all the fish.  

Click on the Graph + Results tab and you will see at the bottom the estimate for the total
number of fish in this 30 m reach of stream (the screen is shown below). The estimated
population size is 172, with upper and lower 95% confidence intervals of 155 and 189. A
glance at the graph indicates that the predicted number of captures is quite a good fit to
the data, and the constant probability model was found to give a good fit (Chi-squared =
0.34, p > 0.9525)
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Now we will examine the estimate for large trout alone.

First click on the Data tab again, and click on the title columns until only the > 20 cm
trout column has a red dot in. It will look like this:
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Now select the Constant p method from the Method drop-down menu. To look at the
result click on the Graph + Results tab, and you will see the graph shown below. This
gives a population estimate for large trout of 22 with upper and lower 95% confidence
intervals of 22 and 23.4. A glance at the graph indicates that the predicted number of
captures is quite a good fit to the data and the constant probability model was found to
give a good fit (Chi-squared = 0.98, p = 0.8054)

Trout clearly fit the constant p model rather well; now we will look at the minnow data.
The minnow is a small fish and, due to its size,  it is difficult to sample well with electric
fishing equipment. So we expect a much lower probability of capture. 

First open the Data tab again and click on the title columns until you see a red dot in the
Minnow column:
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Now select the Constant p method from the Method drop-down menu. To look at the
results, click on the Graph + Results tab and you will see the graph shown below. 
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This gives a population estimate for minnow of 51 with upper and lower 95% confidence
intervals of 24 and 137. These confidence intervals are wide and reflect the fact that the
graph shows that minnow numbers did not decline sharply with increased sampling. This
is shown by looking at the Calculations tab which shows that the estimated probability of
capture of a minnow on each sweep of the stream is only 0.118 or about 12%. In
contrast the probability of capture of a large trout was about 59%.
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5 Installation

 Place the Removal Sampling 2 CD in the drive. 
 The installation process should begin automatically; follow the on-screen instructions.
 If the CD does not auto-run, browse in Windows Explorer or My Computer, and

double-click the file named Setup.exe in the root directory of the CD.

When installation is complete there will be a Removal Sampling entry on your Start menu
and a folder (directory) called C:\Program Files\Removal Sampling, which holds the
program and associated files. An uninstall program will also be created, accessible from
the Start menu should you wish to remove the program. If you wish to make a shortcut
to the program on your desktop, go to the Removal Sampling 2 entry on the Start menu,
right-click on it, and choose Send To: Desktop (create shortcut).
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6 System requirements

 An IBM-compatible PC with CD-ROM drive.
 10 MB of free hard disk space
 Windows XP or Vista operating system.

Although Removal Sampling is designed for Windows XP and Vista, it should function
perfectly on older versions of Windows, from 98 onwards. However, we are not able to
guarantee its performance with older operating systems. We do not produce any software
designed to run under the Mac OS, however, our programs should run satisfactorily using
Windows emulation software. Similarly, though we do not produce software to run under
Linux, our programs should run under WINE. We recommend downloading one of our 
demo versions to test this.
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7 How to reference this program

This program should be referenced as: 

Seaby, R. M. H. & Henderson, P. A. (2007) Removal Sampling 2. Pisces Conservation
Ltd., Lymington, England.
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9 Contact Pisces

For most active windows, context sensitive help can be obtained by pressing F1, clicking
on the Help button, selecting the Help drop down menu. or clicking on the right-hand
mouse button and choosing Help from the pop-up menu. 

If pressing F1, make sure that the window that you are seeking help for is the active one.

If you have problems using the program or entering data which you cannot solve, then
contact Pisces Conservation Ltd by e-mailing pisces@pisces-conservation.com or by
phone to UK (0)1590 674000 during office hours (09.00 to 17.00 GMT/BST).

PISCES Conservation Ltd, 
IRC House, The Square
Pennington, Lymington
Hants, SO41 8GN
UK

Telephone 44 (0) 1590 674000
Fax          44 (0) 1590 675599

For more information, details of our other software, and answers to a range of technical
queries, visit our web site at http://www.pisces-conservation.com

To buy software online, visit our shop at www.piscesconservation.com/shop

For details about our consultancy and research work, visit 
http://www.irchouse.demon.co.uk
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